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READ ME FIRST
In case you're not familiar with the terminology,
Read Me First is quite often the name given to a
computer file that contains important information
for people to know prior to using an application.

This section contains some important information to
help you use this book so we thought we'd start
with a Read Me First section.

What skills and knowledge
you will acquire...

The skills and knowledge acquired in Microsoft Excel 2016 - Simple
Calculations are sufficient to be able to use and operate the software
effectively.

What you'll need to know
before beginning this
course...

Microsoft Excel 2016 - Simple Calculations assumes little or no
knowledge of the software. However, it would be beneficial to have a
general understanding of personal computers and the Windows operating
system environment.

The objectives of this guide…

At the completion of this course you should be able to:
understand, create and work with formulas and functions
understand and use formula cell referencing
use data linking to create more efficient workbooks
use a variety of statistical
1 functions
use the date and time functions to perform calculations

What you get in a chapter...

Each chapter begins with a summary page listing the topics covered in
that chapter. The chapter then consists of single-page topic sheets
pertaining to the theme of 4the chapter.

What you'll need to have
before commencing this
course...

Many of the topics in this learning guide require you to open an existing
file with data in it. These files can be obtained from your instructor and
need the product code for this course which is ExcelSimpleCalcs.

As you work through this
guide…

It is strongly recommended that you close all open files, if any, prior to
commencing each new chapter in this learning guide. Each chapter,
where relevant, has its own set of exercise files and any from a previous
chapter are no longer required.

Where to from here...

Have a look at the next page which explains how a topic page works,
ensure that you have access to the exercise files (see above), and you're
ready to make a start.
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WORKING WITH TOPIC SHEETS
The majority of this book comprises single-page
topic sheets. There are two types of topic sheets:
task and reference. The layout of both is similar
– an overview at the top, detail in the centre and

additional reference (optional) material at the
bottom. Task sheets contain a Try This Yourself
step-by-step exercise panel in the detail area as
shown below.

1
2

3
4

5

6





Topic name



In Task topic sheets screen shots and graphics provide a visual clue as to what
will happen when you work through the Try This Yourself practice exercise. In
Reference topic sheets the screen shots and graphics are used to visually
represent information and concepts.




The For Your Reference (optional) element provides a quick summary of the steps
required to perform a task. These usually only appear in Task-based topic sheets.

General topic overview provides an introduction to the topic
Try This Yourself (Task-based topic sheets) is a detailed step-by-step practice
exercise for you to work through. In Reference topic sheets this is usually replaced
by a box with reference information.

The Handy To Know (optional) element provides additional information such as
alternate ways of accomplishing a task or further information providing handy tips.
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Microsoft Excel 2016 - Simple Calculations

CHAPTER 1

FORMULAS AND FUNCTIONS

INFOCUS

Just as Microsoft Word allows you to work with words, Excel allows you to
process numbers. This is done with formulas that are used to perform
calculations.
Formulas can perform simple tasks such as adding up a few cells or more
complex operations. In addition, Excel also contains several hundred preprogrammed formulas for performing a variety of different types of calculations
– these are known as functions.

In this session you will:
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gain an understanding of formulas
learn how to create formulas that add using the pointing
method
learn how to create formulas that subtract
learn how to create formulas that multiply and divide
gain an understanding of what functions are and how
they work
learn how to use the SUM function to add values
learn how to sum non-contiguous ranges
learn how to calculate an average
learn how to find a maximum value using the MAX
function
learn how to find a minimum value using the MIN function
learn how to create more complex formulas
learn how to perform What If testing
gain an understanding of common error messages.
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UNDERSTANDING FORMULAS
Formulas are the key to using Excel practically
and efficiently. Formulas, like text, numbers and
dates, are entered into a cell in a worksheet.
Unlike the other data, however, formulas must

begin with an equal (=) sign. In addition, formulas
in Excel adhere to the basic rules of arithmetic
known as BODMAS – so this is one maths lesson
you must understand to master Excel formulas.

How Formulas Work
In Excel every formula that you create must start with an equal
sign ( = ). The equal sign informs Excel that the data entered in
that cell will be a formula and that Excel must therefore perform
a calculation.
For instance, if you type 5+6 in a cell Excel will display 5+6 in
that cell. Excel treats this entry as text and that is why the
numbers are aligned to the left of the cell.
However, if you type =5+6 in a cell Excel will perform the
calculation and display 11 in that cell in the worksheet. When
that cell is active, the formula =5+6 will be displayed in the
Formula Bar. When working with formulas, it is important to
look at the Formula Bar as well as the cell in the worksheet so
that you know whether the cell contains a formula or normal
data.

Cell Referencing For Perfect Formulas
Though typing a formula such as =5+6 into a cell is an easy way to find the solution to a simple equation,
it can make things more complicated later on. For example, if the data changes or you have mistyped a
number, it can be time-consuming to enter the formula again. This is why it is better to type the numbers
into their own separate cells, then type the cell addresses that refer to those numbers in the formula
instead of typing numbers straight into a formula. This is especially useful when working with large
amounts of data.
In the example shown to the right, the value 5 has been typed
into cell B2, the value 6 has been typed into cell B3, and the
formula =B2+B3 has been typed into cell B4. This might seem
like a lot more typing than you might otherwise do, but the real
gain lies in the functionality of what is done here. For example,
if you need to know what 6 plus 6 equals, you simply type 6 in
cell B2, and the formula in cell B4 will instantly update to show
you the answer.
This occurs because Excel interprets the formula in cell B4 and
calculates that cell B4 must equal the data in cell B2 plus the
data in cell B3. If the data in either of the two referenced cells is
changed, this formula is immediately recalculated and provides
the latest result.

Rules For Using Formulas
There are four main arithmetic operations that can be performed in an Excel formula. Excel adheres to
the BODMAS rules of arithmetic to determine the order in which calculations in any given formula are
performed. The order is – Brackets, then Orders (otherwise known as Powers, or Roots, or Exponents, or
Indices), then Division, then Multiplication, then Addition, then Subtraction. For example, the equation
3 + 2 x 10 could equal either 50 or 23. Using BODMAS the correct answer is 23: 2 x 10 = 20 + 3 = 23.
Computers do not have the standard arithmetic symbols that we are accustomed to. The keys on the
keyboard that you will use to perform the four main arithmetic operations are shown below.
Addition
Subtraction
Multiplication

© 2017 The University of Nottingham
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CREATING FORMULAS THAT ADD
In Excel you can create formulas by typing them
directly into the cells, or by clicking on the cells.
When clicking on a cell, Excel types the cell
address into the formula for you. This helps to

Open
File

Try This Yourself:
Before starting this
exercise you MUST open
the file Formulas_1.xlsx...



Click in cell E15




Type = to start the formula

avoid typing errors in your formulas. In this exercise
you will use this method to create a formula that
adds the gross pays for Alpheius Global
Enterprises.

3

This is where we will add
up all of the gross pays…

Click in cell E8, then type +
(the plus sign)

4

The E8 cell reference will
be added to the formula
and the active cell pointer
will move back to cell E15
ready for the next cell
reference – the formula is
actually being typed as
you click on the cells…



Repeat step 3 for each cell
from cell E9 to cell E12 so
that the formula eventually
reads
=E8+E9+E10+E11+E12+
Remember to press + after
you click in each cell…



6

Click in cell E13 to add this
to the end of the formula
We don’t need to type + as
there are no more cells to
add to the formula…



Press
formula

to complete the

For Your Reference…

Handy to Know…

To create a formula using the pointing method:
1. Click in the cell which will hold the formula
2. Type = then click on each of the desired cells
(typing + after all except for the last)
3. Press

 When creating a formula, it can be useful to
allow Excel to enter the cell references as
you click on various cells, as this way you
can actually see the formula being built on
the screen for you.
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CREATING FORMULAS THAT SUBTRACT
There are many different types of formulas that
can be written in Excel. Virtually any type of
mathematical operation can be performed. For
instance, you can create formulas that subtract

Same
File

Try This Yourself:

one value from another. Because it is usual to
include cell references in the formula, when any
values change so to do the formula results.

4

Continue using the previous
file with this exercise, or open
the file Formulas_2.xlsx...



Click on the Subtraction
worksheet tab at the bottom of
your screen to make it the
active worksheet



Click in cell G8
This is where we need to
calculate Angelo Marcuzzo’s
Net Pay…



Type = to start the formula,
then click on the gross pay
value in cell E8



Type – (the minus sign) to
indicate that you wish to
subtract from this value, then
click on the tax value in cell F8



Press
formula

6

to complete the

We can now fill this formula
down for the other staff…



Click in cell G8, then point to
the small square at the bottom
right of the cell until the mouse
pointer changes to a small
cross



Click and drag down to cell
G15, then release the mouse
button



Click in cell G14 and press
to delete the unwanted
formula

8

For Your Reference…

Handy to Know…

To create a subtraction formula:
1. Click on the cell to hold the subtraction
2. Type = (equal sign), then click in the first cell
3. Type – (minus sign), then click on the cell to
subtract
4. Press

 You can mix various arithmetic signs in a
formula to create more complex formulas.
For example, you can have a complex
formula that adds specific values and
subtracts others.
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FORMULAS THAT MULTIPLY AND DIVIDE
Basic formulas involve the same types of
arithmetical operations within the one calculation
– that is, addition, subtraction, multiplication, or
division. You can mix these operations within the

one formula as much and as often as you need.
However, you should always keep in mind the
basic rules of BODMAS, especially where division
is concerned.

Same
File

Try This Yourself:
Continue using the
previous file with this
exercise, or open the file
Formulas_3.xlsx...

In this exercise we’ll
calculate the
superannuation payable for
employees, which is 9% of
their gross pay. The logic
is:

2

gross x super rate
gross x 9 divided by 100
gross * (9 / 100)
Note that the brackets are
for readability only and
won’t affect the
calculation…



Click on the More
Complex worksheet tab,
then click in cell H8

4

This is where we will
calculate Angelo’s super…



Type = to start the formula,
click in cell E8, then type
*(9/100)



Press
formula

to complete the

Let’s fill down now…



Click in cell H8, then click
and drag the fill handle
down to cell H13



Repeat steps 4 and 5 to fill
across to cell H15 from cell
G15

5

For Your Reference…

Handy to Know…

To create a formula that multiplies or divides:

 More complex formulas can be managed
using brackets. For example, if you want to
multiply two numbers then divide them by the
product of another two numbers, enclose
both multiplication parts of the equation in
brackets separated by a division sign. For
example, (A*B)/(C*D).

 For multiplication, separate the variables with
an asterisk (*)
 For division, separate the variables with a
forward slash (/)

© 2017 The University of Nottingham
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UNDERSTANDING FUNCTIONS
Imagine creating a formula that adds fifty different
cells, or a formula that a bank would use to work
out monthly payments on a home loan. Both
these formulas would be very long and complex

and involve lots of typing. Fortunately, these types
of calculations and others can be performed in
Excel using built-in functions.

Functions Overview
Functions are simply pre-programmed formulas already provided for you in Excel which can perform
calculations covering a wide range of categories including statistics, date and time arithmetic, financial
calculations, lists, engineering and much more.
Just like when you create a formulas, functions must start with an equal sign. The equal sign is then
followed by the specific name of the function (usually a descriptive name which indicates the purpose
of the function). Most functions also require additional information known as arguments which are
supplied to the function in brackets after the function name. Functions are therefore written as follows:
=name(arguments)
The arguments are quite often cell or range references that contain values that can be used in the
function. For example, the most common function is the SUM function which, as its name suggests, is
used to sum or add values together. If you wanted to add all of the values in the cells from B10 to B25
you would write this function as:
=SUM(B10:B25)
As you can see this is much simpler than writing your own referential formula which would look like:
=B10+B11+B12+B13+B14+B15+B16+B17+B18+B19+B20+B21+B22+B23+B24+B25
Imagine writing and proofing a formula where you had to add 200 cells!

Typing Functions
If you are familiar with the function that you need you can type it into a cell exactly the same way you
type any other formula. If you are not sure if Excel has a function or you can’t quite remember how it is
written you can use the Insert Function tool on the Formula Bar to assist you. When you click on this
tool the Insert Function dialog box will be presented to you which lists the most recently used or
common functions and also allows you to search for other functions that you might need.

Clicking on the Insert
Function tool will
display the Insert
Function dialog box

The Insert Function dialog box will also type the function out for you and then provide you with a
further dialog box to guide you through the process of specifying the arguments that the function
needs to perform its calculation.

© 2017 The University of Nottingham
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USING THE SUM FUNCTION
One of the most commonly used functions is the
SUM function. This function allows you to add the
values in a range of cells. The function is written
as =SUM(range or ranges to add). You can type

the function and then use the pointing technique to
fill in the arguments. Excel then paints marquees
around the cells involved helping you to track your
progress.

1

Open
File

Try This Yourself:
Before starting this exercise
you MUST open the file
Formulas_4.xlsx...




Click in cell B9, then type
=sum( to start the formula
Click in cell B6, hold down
, then click in cell B8

2

Notice the relative
addressing details, 3R x 1C,
that appears in the tool tip…




Type ), then press
complete the function

to

Click in cell B9, then point to
the fill handle and click and
drag across to cell E9 to fill
across the range



Ensure that the range
B9:E9 is still selected, then,
on the Home tab, click on
Copy in the Clipboard
group



Click in cell B14, hold down
, then click in cells B19
and B24



Release
and press
to paste equivalent
functions into the worksheet

7

For Your Reference…

Handy to Know…

To type a sum function for a contiguous range:
1. Type =sum(
2. Select the range of cells
3. Type )
4. Press

 You can use the AutoSum command in the
Editing group on the Home tab to
automatically enter a sum function based on
a range of cells.

© 2017 The University of Nottingham
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SUMMING NON-CONTIGUOUS RANGES
worksheet. The ability to sum non-contiguous
ranges of data helps you to increase the level of
functionality of your worksheet.

Many users simply use the SUM function to add
a continuous block of data – known as a range.
But with Excel you can write a SUM function that
adds up data from multiple ranges within a

Same
File

Try This Yourself:
Continue using the previous
file with this exercise, or open
the file Formulas_5.xlsx...




Click in cell B26, then type
=sum( to start the formula



Press
to complete the
function, then click in cell B26
again

Click in cell B9, type ,
(comma), then click in cells
B14, B19 and B24 – typing ,
(comma) after each cell except
the last one

You may notice that we didn't
add a right bracket. Excel adds
the bracket for you with
functions that use only one set
of brackets. You can also use
multiple ranges in a function...




5

Click in cell C26, then type
=sum(
Hold down
and use the
mouse to select the following
ranges
C6:C8
C11:C13




2

Press
C26

C16:C18
C21:C23

, then click in cell

Point to the fill handle, then
click and drag to cell E26 to
copy the function across

For Your Reference…

Handy to Know…

To type a sum function for a non-contiguous
range:
1. Type =sum(
2. Click on the first cell to sum
3. Type , and click in the next cell to sum
4. Type ) then press

 The big problem with typing a function is that
there is more chance of making a typing
mistake. Excel has in-built error checking,
called Formula AutoCorrect, that can correct
up to 15 of the most common mistakes users
make (e.g. the right bracket to finish a
function).

© 2017 The University of Nottingham
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CALCULATING AN AVERAGE
The AVERAGE function allows you to average
the values in a range of cells. It is written in much
the same way as the SUM function, for example,
=AVERAGE(range of cells to average). The

average function can be applied using the
Functions Wizard, a part of Excel that takes you
through the process of creating a function, or you
can type it in yourself if you are comfortable with it.

Same
File

Try This Yourself:
Continue using the previous
file with this exercise, or
open the file
Formulas_6.xlsx...



Click in cell B29, then click
on Insert Function, as
shown, to display the Insert
Function dialog box



Click on AVERAGE in Select
a function, then click on
[OK] to display the Function
Arguments dialog box



Click on the Range Selector
for Number1 to minimise the
wizard, then hold down
and select the following
ranges

B6:B8
B11:B13



1

B16:B18
B21:B23

Press
to complete the
range specifications, then
click on [OK] to complete the
process
Let’s use the AutoSum
function…



Click in cell B34, click on the
Home tab, then click on the
drop arrow for AutoSum in
the Editing group and select
Average



Click in cell B9, hold down
, click in cells B14, B19
and B24, then press
to
complete the formula

3

6

For Your Reference…

Handy to Know…

To insert an average function:
1. Click in the cell then click on the Insert
Function tool
2. Click on AVERAGE in Select a function
3. Insert the required ranges then click on [OK]

 You can type queries like “How do I work out
the monthly payment for a car loan?” into the
Search box in the Insert Function dialog
box. Once you have selected a function from
the Select a function list, the Function
Arguments dialog box will help you to enter
the values into the function.

© 2017 The University of Nottingham
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FINDING A MAXIMUM VALUE
When reviewing a long list of numbers it is
sometimes difficult to see which is the largest
value in the list. The MAX function allows you to
extract the highest value from a range of cells. It

Same
File

Try This Yourself:
Continue using the previous
file with this exercise, or open
the file Formulas_7.xlsx...



Click in cell B30, then click on
Insert Function (to the left of
the Formula Bar) to display
the Insert Function dialog box



Click on the drop arrow for Or
select a category and click on
All



Scroll down and click on MAX
in Select a function, then
click on [OK] to display the
Function Arguments dialog
box



Click on the Range Selector
tool for Number1, then hold
down
and select the
following ranges:
B6:B8
B11:B13

B16:B18
B21:B23



Press
to complete the
range specifications, then click
on [OK] to complete the
process



Click in cell B35, click on the
Home tab, click on the drop
arrow for the AutoSum
command in the Editing
group, then select Max



Click in cell B9, hold down
, click in cells B14, B19 and
B24, then press
to
complete the formula

is written in much the same way as the SUM
function: =MAX(range of cells). The function can
either be typed into the worksheet or entered using
the Function Wizard.

3

4

7

For Your Reference…

Handy to Know…

To insert a maximum function:
1. Click in the cell then click on the Insert
Function tool
2. Click on MAX in Select a function
3. Insert the required ranges then click on [OK]

 The MAX function is ideal for charting high
points over a seasonal period. For example,
you may have monthly sales figures and use
a MAX function to display the maximum each
month. This series can then be charted to
show the high points in the sales.

© 2017 The University of Nottingham
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FINDING A MINIMUM VALUE
The Minimum or MIN function allows you to
extract the lowest value from a range of values. It
is written in much the same way as the SUM
function or MAX function: =MIN(range of cells).

Same
File

Try This Yourself:

2

Continue using the previous
file with this exercise, or
open the file
Formulas_8.xlsx...



Click in cell B31, then click
on Insert Function (to the
left of the Formula Bar) to
display the Insert Function
dialog box



Click on the drop arrow for
Or select a category and
click on Statistical



Scroll down and click on
MIN in Select a function,
then click on [OK] to display
the Function Arguments
dialog box



Click on the Range Selector
tool to minimise the wizard,
then hold down
and
select the following ranges:
B6:B8
B11:B13



The function can be applied using the Function
Wizard, or by typing the function in detail directly
into the cell.

B16:B18
B21:B23

4

Press
to complete the
range specifications, then
click on [OK] to complete
the process
Let’s simply type the
function this time…




Click in cell B36 and type
=MIN(B9,B14,B19,B24)
Press
formula

to complete the
7

For Your Reference…

Handy to Know…

To insert a minimum function:
1. Click in the cell then click on the Insert
Function tool
2. Click on MIN in Select a function
3. Insert the required ranges then click on [OK]

 You might use a MIN function in real life to
find the lowest value in a large range of
numbers. For example, in a large inventory it
can be used to work out which product is the
slowest seller.

© 2017 The University of Nottingham

Page 11

Chapter 1 - Formulas and Functions

Microsoft Excel 2016 - Simple Calculations

CREATING MORE COMPLEX FORMULAS
You will often find that you are faced with
creating formulas that need to add, subtract,
multiply, divide, and so on, all in the same
formula. These more complex formulas need to

be thoughtfully planned. Begin by breaking a
complex formula down into its component parts
then apply the rules of BODMAS to ensure the
calculations are performed as required.

Open
File

Try This Yourself:



Before starting this exercise you
MUST open the file
Formulas_9.xlsx...

Click on the Multiplication &
Addition worksheet tab
We need to create a formula that
determines the average number
of hours worked by each
employee and then calculate
how much the weekly payroll
would be if all employees were
paid a flat 22.50 per hour. There
are two component parts here –
first we need to find the average
hours worked, then multiply this
by the hourly rate times the
number of employees…



Click in cell E16, then type
=(sum(C8:C13)/6) but don’t
press
This formula calculates the
average hours worked by the
employees (an Average function
would perform the same
calculation)….



2

3

Type * (the asterisk symbol),
then type (B16*6)
* instructs Excel we want to
multiply this average. This part
of the formula multiplies the
hourly rate by the number of
employees…



Press
formula

to complete the
4

For Your Reference…

Handy to Know…

To create complex formulas:
1. Plan your formula
2. Type your formula (keeping in mind the rules
of BODMAS)

 You may sometimes wish to enclose two
component parts of a formula in brackets.
While this is not necessary from a BODMAS
point of view it does make the formula easier
to read.
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WHAT IF FORMULAS
When you’ve added formulas to your worksheet
you have a calculation model. Every time you
change one of the dependent values that are
used in a formula, that formula and any others

Same File

Try This Yourself:



that are dependent on it will update instantly. This
allows you to perform what-if testing. For example,
you can enter what if formulas that answer
questions like ‘what if inflation goes up by 2%?’.

1

Continue using the
previous file with this
exercise, or open the file
Formulas_10.xlsx...
Click on the Summary
worksheet tab
Notice the values on this
worksheet…



Click on the More
Complex worksheet tab
to display the
worksheet, then click in
cell C8 which contains
the hours for Angelo
Marcuzzo



Type 37, then press
Notice how the formulas
update the values in row
15 as you change the
dependent data…



Click on the hours for
the other employees
and type the new values
as shown



Click on the Summary
worksheet tab to return
to the Summary
worksheet

4

5

The values will have
automatically
recalculated to reflect
the changes

For Your Reference…

Handy to Know…

To use a formula for what-if testing:
1. Change the value in the cell that is
referenced by a formula
2. Evaluate the changed results in the formula
results cell

Excel has three different functions that can be
applied for more advanced what-if testing:

© 2017 The University of Nottingham
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 SUMIF calculates a total amount based
on a single condition.
 COUNTIF counts the number of times a
value appears in a range of cells.
 IF is used for either/or scenarios.
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COMMON ERROR MESSAGES
Microsoft Excel has some in-built messages that
can assist you when something goes wrong with
a formula. These messages appear in the cell
that contains the formula, and sometimes also

other formula cells that depend upon it. The
messages are always prefixed with a hash sign (#)
and appear with a code. The more common error
messages are listed below.

A Line of Hash (#) Signs
Sometimes referred to as “tramlines”, a line of hash
signs usually occurs because a column is not wide
enough to display the numbers in the cell or
formula. Widening the column will correct this
problem – you can drag the column heading until
the value in the cell appears as it should.

#DIV/0!
This message means you are trying to divide a value by
zero – this is mathematically impossible. In the example
at the left we are trying to find the average number of
persons per household. All is fine as long as there is a
value greater than zero in cell B3 (Houses). As soon as
we change this to a zero an error message appears in
the formula cell (B5).
To prevent the error you will need to enter a value
greater than zero into cell B3, the divisor cell.

#VALUE!
In this message Excel is advising that something in the
formula is not a value and therefore a calculation can’t be
made.
A close examination of the example at the left shows cell
B3 contains the word “three”. Therefore the formula in
cell B5 is trying to divide 192,664 (in cell B2) with a word,
which doesn’t make sense.
To fix the error, a value (a number) will need to be
entered in cell B3.

#NAME?
This message appears when text is found in a
formula that can’t be matched to either a
legitimate function or range name.
In the example to the left, the formula has been
entered as =SOME(B3:B7) – there is no such
function as SOME, and presumably the author
should have typed =SUM(B3:B7).

© 2017 The University of Nottingham
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CHAPTER 2

FORMULA REFERENCING

INFOCUS

Formulas provide the key to working successfully with Microsoft
Excel. When you create a formula you write it using cell references
rather than actual hard-coded values.
It is important to fully understand and comprehend this concept of
cell referencing to be able to utilise the full potential of Microsoft
Excel. There are also some potential traps that you can fall into with
cell referencing if you don’t take enough care.

In this session you will:
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gain an understanding of relative and absolute cell
addressing in formulas
learn how to confidently create relative formulas in a
worksheet
learn how to identify potential problems with relative
formulas
learn how to create absolute references in a formula
learn how to create mixed references.
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ABSOLUTE VERSUS RELATIVE REFERENCING
Excel is a calculation tool and as such is geared
around the concept of formulas. Formulas are
entered into a worksheet using cell references
rather than actual values. Each time a formula is

entered using cell referencing, a shape is created
and it is this shape which determines where Excel
goes to pick up values for use in the calculation.

Understanding Formula Shapes
When you create a formula you don’t enter numbers into the formula – you enter cell references. This
creates a great time advantage when you need to duplicate that formula in other cells. Formulas are
merely shapes that reference cells in specific locations in the worksheet or workbook. In the example
below, say you have a formula in cell E8 that is written as =C8*D8. Excel interprets this as a shape
that says “from my current position (E8) go left two cells (C8), take the value there and multiply it by
the value one cell left (D8)”. This becomes the formula shape left two multiply by left one.
When this formula, or shape, is then copied or filled to adjacent cells it is the shape that is copied and
the cell references within those copied formulas change relative to the shape (which doesn’t change).
For example, if you copy =C8*D8 from cell E8 to cell E9 the formula in cell E9 changes to =C9*D9 –
but the shape is still left one multiply by left two.
This is called relative referencing – because the cell address changes relative to the current location.

Absolute Referencing
There will be times however when one or more cell references in a formula are always required to be
located in a specific cell, row, or column. In the example below, sales tax of 10% is located in cell B4
and must always be referenced from cell B4. The sales tax for the dining table is calculated using the
formula =B8*B4 while the sales tax for the sofa is calculated using the formula =B9*B4. These are
different shapes; if you were to copy the formula from cell C8 (=B8*B4) to cell C9 it would copy the
shape and the formula would be =B9*B5, which is wrong.

When dealing with cells in formulas that must be referenced from the same location, you must fix
these cell references by making them absolute. This is done by placing a $ sign in front of either or
both the row and column co-ordinate of the cell depending on which of these has to remain fixed (e.g.
$B$4, $B4, or B$4). In the example above, both row and column co-ordinates need to be fixed and
the formula in cell C8 should be written as =B8*$B$4 before it can be copied to adjacent cells.

© 2017 The University of Nottingham
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RELATIVE FORMULAS
Most of the formulas that you enter into a
worksheet, unless you are dealing with quite
complex mathematical modelling, will be relative
formulas where the cell references will be able

Open
File

Try This Yourself:

to change when the formulas are copied to other
locations. This is particularly true of columnar
worksheets where there is a series of columns that
all have the same shape and structure.

2

Before starting this
exercise you MUST open
the file Formula
Referencing_1.xlsx...




Click in cell B9 to make it
the active cell




Press
to complete
the formula

On the Home tab, click
on AutoSum in the
Editing group to insert
the AutoSum function in
the cell

4

Click in cell B9 again,
then click and drag the
fill handle to cell E9

This will copy the formula
shape from B9 to E9…




Click in cell F6 to make it
the active cell




Press
to complete
the formula

6

Click on AutoSum in the
Editing group to insert
the AutoSum function in
this cell
8

Click in cell F6 again,
then click and drag the
fill handle to cell F9
This will copy the formula
from cell F6 to cell F9

For Your Reference…

Handy to Know…

To create a relative formula:
1. Click in the cell in which you want the
formula
2. Type or enter the formula and ensure that
the formula contains references to other cells

 When the same formula shape is used in
each of the cells when a formula is copied,
the formulas will be copied successfully and
correctly. This is the real benefit of relative
formulas.

© 2017 The University of Nottingham
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PROBLEMS WITH RELATIVE FORMULAS
Copying formulas can present problems when
the shape of the formula varies from cell to cell.
This can occur when one or more values in a
formula must be located in a specific cell, row, or

Open
File

Try This Yourself:



2

Before starting this
exercise you MUST open
the file Formula
Referencing_2.xlsx...
Click in cell C11
This is where we need to
calculate the product’s
surcharge…



Type =B11*B5



Press
to complete
the formula

3

Notice the shape of the
formula, as indicated by
the highlighted cells…

Now we can copy (or
perhaps fill, as the
destination cells are
adjacent) to the other
cells…




column – that is, the formula must include an
absolute cell reference. In this exercise you will
see some strange values when you copy a formula
to other cells using the default copying method.

5

Click in cell C11 again
Click and drag the fill
handle down to cell C22
The text #VALUE! has
appeared in some cells.
This shows the formula
hasn’t worked correctly in
these cells

For Your Information…

For Your Information (cont’d)…

So what has gone wrong with the formulas above?
The whole problem hinges on the fact that each of
the formulas in column C uses a different shape
from the other formulas. For example, the first
formula in cell C11 is =B11*B5. The shape of this
formula is one left, then six up and one left.

The second formula in cell C12 has become
=B12*B6 because it uses the same shape as
the originating formula in cell C11. In reality, the
formula should be =B12*B5. All of the formulas
above must reference the Head Office
Surcharge of 12% which is in cell B5 – that is,
the cell reference must be absolute.

© 2017 The University of Nottingham

Page 18

Chapter 2 - Formula Referencing

Microsoft Excel 2016 - Simple Calculations

CREATING ABSOLUTE REFERENCES
There will be times when you need to create a
formula which references cells that must remain
the same even when it is copied around the
worksheet. That is, you will need to make the cell

Same
File

Try This Yourself:

references absolute. A cell reference in a formula
is made absolute by preceding its row coordinate or
its column coordinate or both with a $ sign.

1

Continue using the previous
file with this exercise, or open
the file Formula
Referencing_3.xlsx...



Click in cell C11, then click in
the B5 reference of the
formula in the Formula Bar,
as shown



Press
several times to
cycle the reference through
various $ sign configurations

3

is known as the absolute
reference key…



Press
until cell B5 appears
as $B$5, as shown
This will lock in both the
column and the row
co-ordinate so that it will
remain the same wherever it
is filled or copied to…




Press
editing

5

to complete the

Click in cell C11, then click
and drag the fill handle down
to cell C22 to fill the formulas
down
All of the formulas in the
Surcharge column will now be
locked into cell B5

For Your Reference…

Handy to Know…

To make a cell reference absolute:

 To make a row reference absolute, press
twice to insert $ before the row reference
only. To make a column reference absolute,
press
three times to insert $ before the
column reference only.

 Press
to insert $ before the row and
column references, or type $ before each
To remove absolute references:
 Press
until all $ are removed, or delete
the $ from the formula
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CREATING MIXED REFERENCES
Sometimes problems with formulas are more
subtle. This often occurs when the cell reference
only needs part of its coordinates locked in place.
In this exercise we will use a formula to create

Open
File

Try This Yourself:




three price lists. Because we will copy the formula
both across columns and down rows, we will need
to apply only partial absolution to the cell
references used in the formulas.

2

Before starting this exercise you
MUST open the file Formula
Referencing_4.xlsx...

Click in cell E11, type
=D11-(D11*E9), then press
Use the fill handle to fill down to
cell E22 then across to cell G22
All of the formulas need to be
locked into the Surcharge
column (D) and the volume
discount row (9)…



Click in cell E11, then click on
the first D11 reference in the
formula in the Formula Bar



Press
three times until the
reference appears as $D11

4

This ensures that the column
will be locked in but that the row
is free to change…




Click on the second D11
reference in the Formula Bar,
then press
three times until
the reference appears as $D11

6

Click on the E9 reference in the
Formula Bar, press
twice
until the reference appears as
E$9, then press
This ensures that the row is
locked in but that the column
can change…



Click in cell E11, then use the fill
handle to fill down to cell E22
and across to cell G22

For Your Information…

For Your Information (cont’d)…

In this scenario we created a formula to calculate a
discounted product price. As we copy the formula
to the right it picks up the wrong product price.
Then, as we copy the formula down it may,
depending upon which column it is in, pick up the
correct product price, but it doesn't pick up the
correct percentage.

So, as we copy the formula across we need to
ensure that the column coordinate pointing to
the original price is locked, but that the row is
free to change as we copy down: =$D11($D11*E9). However, the percentage is always
in row 9. Therefore, the formula needs to be
further modified: =$D11-($D11*E$9).
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CHAPTER 3

DATA LINKING

INFOCUS

The process of displaying or using data that is located in another
cell, worksheet, or workbook, is known as data linking.
Excel enables you to link the data in your worksheet with data in
other worksheets, other workbooks and even other applications.

In this session you will:
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gain an understanding of data linking
learn how to create links between worksheets
learn how to link between workbooks
learn how to update links between workbooks.
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UNDERSTANDING DATA LINKING
Links between worksheets and workbooks can
be created in Excel by including workbook and
worksheet names, as well as the cell reference,
within a formula. An internal link refers to one

within the same file, while an external link refers to
a link with another file. The cells referenced by a
link are known as the source data. When source
data changes, the linked cells will also change.

The Advantages of Linking Data in Excel
 Linking data from one worksheet to another worksheet ensures that the core data is entered or
calculated only once and then shared with other files.
 You can develop a large system using smaller, more manageable worksheets and workbooks.
 Linked workbooks do not all need to be open for the links to be updated, freeing memory for other
activities.

 Separate modules can be created and managed by different people.

The Syntax of a Link
A typical link has the following structure:
=drive:\path\[filename]worksheet name!cell reference
The full path name is only displayed when the source file is not opened.
External link to
a closed
workbook

Internal link to
another
worksheet in
the same
workbook

External link to
an open
workbook

© 2017 The University of Nottingham
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LINKING BETWEEN WORKSHEETS
You can link cells between worksheets in a
workbook by preceding the source cell reference
in the formula with the sheet name, followed by
an exclamation mark. For example, if you want to

work with cell B6 in the Accounts sheet, your
reference to that cell would be Accounts!B6. A
common use for this technique is to create a
summary sheet of other sheets in a workbook.

2

Try This Yourself:
Before starting this exercise you
MUST open the file Linking_1.xlsx...
This worksheet contains data for
three years on separate worksheets
and a summary page at the front...




On the Summary Data worksheet
tab, click in cell B6, then type =
Click on the worksheet tab for Year
2012, click in cell F6, then press
to complete the formula
Let’s try another technique...



Click in cell B8, type =Year2011!E4,
then press

4

You can add multiple cell references
by using a plus sign between each
cell reference ...



Click in cell B13, type =, click on the
worksheet tab for Year2011, click in
cell F4, then type +



Use the techniques in step 4 to
continue building the formula in cell
B13 so that it reads:
=Year2011!F4+Year2012!F4+Year2
013!F4




Press

to complete the formula

Click in cell B15, then type the
formula

=Year2011!F8+Year2012!F8+Year2
013!F8



Press

to complete the formula
8

For Your Reference…

Handy to Know…

To create a link between worksheets:
1. Type as much of the formula as is required
before the linked cell reference
2. Click on the cell you wish to link to, or type
the reference for that cell
3. Press
or continue with the formula

 When creating links in a workbook, although
clicking on each cell to pick up the reference
may seem tedious, it guarantees the
accuracy of the reference and therefore your
formula.
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LINKING BETWEEN WORKBOOKS
Linking between workbooks involves the same
basic steps as linking between worksheets within
a workbook. In addition, the linking formula must
be very specific so that Excel can find the file that

you want to link to. If the workbook resides in
another folder, the formula must include the full
path to the workbook file. Workbook names need to
be enclosed in square brackets.

Open
File

Try This Yourself:
Before starting this exercise
you MUST open the file
Linking_2.xlsx...





Press
+
workbook



Click on the Year2013
worksheet tab, then click in cell
B8




Type *39%, then press

to create a new

Enter the headings as shown,
click in cell A5, then type =

2

Click on the View tab, click on
Switch Windows in the
Window group, then select 2
Linking_2.xlsx

Click in cell A5, then examine
the formula in the Formula Bar
We need to make the cell
reference relative so we can fill
the formula to other cells...



Double-click on $B$8 in the
Formula Bar, type B8, then
press



Click in cell A5, then click and
drag the fill handle to copy the
formula across to cell D5



On the Home tab, click on
Comma Style in the Number
group to format the numbers,
then close the workbook
without saving it

4

8

For Your Reference…

Handy to Know…

To link between workbooks:
1. Type as much of the formula as is required
before the linked cell reference
2. Switch to the other workbook, then click on
the cell(s)
3. Press
or continue with the formula

 Links to cells in other workbooks are
automatically absolute (i.e. displayed with $
signs). This means that if you copy the
formula, the column and row references will
remain unchanged. You must remove the
dollar signs first if you want to fill the formula
to other cells.
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UPDATING LINKS BETWEEN WORKBOOKS
The workbook that contains the original data is
known as the source workbook. The workbook
that contains the link formula is known as the
destination workbook. When the source is open,

the destination workbook is automatically updated.
If you open the destination workbook when the
source is closed, you can update it from the source
immediately or update it later.

Same
File

Try This Yourself:
Continue using the previous
file with this exercise, or open
the file Linking_3.xlsx...




Click on the worksheet tab for
Year2013



Press
+
to save the
workbook, then press
+
to close it



Click on the File tab, click on
Open in the left pane, click on
[Browse], then navigate to
the course files folder



Click in cell B4, type 678000,
then press
to change the
data

2
5 If this message does not appear, you may need to enable automatic
updating in the Information bar.

Open Workbook
Linking.xlsx
As this file contains links to
another file, a message may
appear…



Click on [Update]
As the file that this workbook
is linked to is trustworthy you
can click on [Update] so that
the figure for Qtr1 will reflect
the changes made in the
linked workbook.
If you didn’t know or didn’t
trust the linked file you could
click on [Don’t Update] and
the data would not be updated

6

If you choose not to update the data when you first open your
workbook, you can always update it via the Edit Links dialog box.
This way you can see where the linked file is located. Simply click
on the Data tab, then click on Edit Links and click on [Update
Values].
If a message does not appear when you open the linked file, click on
File > Options >Trust Centre > [Trust Centre Settings] > External
Content and ensure that under Security Settings for Workbook Links
you select Prompt user on automatic update for Workbook Links.

For Your Reference…

Handy to Know…

To update links between workbooks:
1. Open the destination workbook
2. Click on [Update]

 Using the Excel Options dialog box you can
choose to automatically update linked
workbooks, prompt users for automatic
updates or disable automatic updating.
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NOTES:
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CHAPTER 4

STATISTICAL FUNCTIONS

INFOCUS

Excel contains a large number of statistical functions. These can be
used to perform relatively simple operations such as summing,
averaging and finding minimum and maximum values.
They also allow you to perform standard statistical operations such
as calculating standard deviation, variance, the median and the like.

In this session you will:
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gain an understanding of statistical functions
learn how to use the status bar to view statistics
learn how to count cells using functions
learn how to count empty cells in a range
learn how to count conditionally
learn how to use the MODE function
learn how to use the MEDIAN function
learn how to use the LARGE and SMALL functions
learn how to estimate the standard deviation
learn how to use the VAR function.
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UNDERSTANDING STATISTICAL FUNCTIONS
Statistical functions range from the simple SUM
to highly specialised functions for scientific,
engineering and medical applications. In all there
are 98 statistical functions listed in Excel. For

reference purposes only, the statistical functions
are listed below.

Statistical Functions List
To view the list of available financial functions, click on the Formulas tab, then click on More Functions in the
Function Library group and point to Statistical. This will display a sub-menu which lists the statistical
functions from A-Z. Clicking on a function will open the Function Arguments dialog box. To view more
information on the function you can click on Help on this function in the bottom left corner of the dialog box.
This will open the Excel Help window with detailed and specific information on the function.

AVEDEV

F.DIST

LOGEST

RANK.AVG

AVERAGE

F.DIST.RT

LOGNORM.DIST

RANK.EQ

AVERAGEA

F.INV

LOGNORM.INV

RSQ

AVERAGEIF

F.INV.RT

MAX

SKEW

AVERAGEIFS

F.TEST

MAXA

SKEW.P

BETA.DIST

FISHER

MEDIAN

SLOPE

BETA.INV

FISHERINV

MIN

SMALL

BINOM.DIST

FORECAST.ETS **

MINA

STANDARDIZE

BINOM.DIST.RANGE

FORECAST.ETS.CONFINT **

MODE.MULT

STDEV.P

BINOM.INV

FORECAST.ETS.SEASONALITY **

MODE.SNGL

STDEV.S

CHISQ.DIST

FORECAST.ETS.STAT **

NEGBINOM.DIST

STDEVA

CHISQ.DIST.RT

FORECAST.LINEAR **

NORM.DIST

STDEVPA

CHISQ.INV

FREQUENCY

NORM.INV

STEYX

CHISQ.INV.RT

GAMMA

NORM.S.DIST

T.DIST

CHISQ.TEST

GAMMA.DIST

NORM.S.INV

T.DIST.2T

CONFIDENCE.NORM

GAMMA.INV

PEARSON

T.DIST.RT

CONFIDENCE.T

GAMMALN

PERCENTILE.EXC

T.INV

CORREL

GAMMALN.PRECISE

PERCENTILE.INC

T.INV.2T

COUNT

GAUSS

PERCENTRANK.EXC

T.TEST

COUNTA

GEOMEAN

PERCENTRANK.INC

TREND

COUNTBLANK

GROWTH

PERMUT

VAR.P

COUNTIF

HARMEAN

PERMUTATIONA

VAR.S

COUNTIFS

HYPGEOM.DIST

POISSON.DIST

VARA

COVARIANCE.P

INTERCEPT

PHI

VARPA

COVARIANCE.S

KURT

PROB

WEIBULL.DIST

DEVSQ

LARGE

QUARTILE.EXC

Z.TEST

EXPON.DIST

LINEST

QUARTILE.INC

** Statistical functions new to Microsoft Excel 2016.
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STATUS BAR STATISTICS
An area of statistical information that is often
overlooked is the status bar. The status bar can
be configured to perform statistical analysis on
cells and ranges that are selected in the

Open
File

Try This Yourself:

worksheet or workbook. This means you can
access statistical information quickly without having
to create formulas especially for the purpose. It is
ideal for cross-checking totals and other results.

2

Before starting this
exercise you MUST open
the file Statistical
Functions_1.xlsx...

3



On the Sheet1
worksheet, select the
range B5:B10



Read the statistical
calculations that should
appear in the status bar at
the bottom of the screen
This is a very quick and
easy way to view the
Sum, Average and Count
statistics for selected
cells...



Right-click on the status
bar to display the shortcut
menu
There are a number of
options that you can hide
or display on the status
bar...



Click on Count so it
appears without a tick,
then press
to hide the
menu
The Count statistics no
longer appear on the
status bar...



Repeat steps 3 and 4 to
display Count on the
status bar once more

4

For Your Reference…

Handy to Know…

To use the status bar calculations:
1. Select the cells
2. Read the figure shown in the status bar
3. Right-click on the status bar to display a
shortcut menu of options
4. Click on an option to show/hide it

 The other statistical function options
available in the Status bar shortcut menu
are: Numerical Count (COUNT), Minimum
(MIN) and Maximum (MAX).
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 The Count (COUNTA) option shown in the
status bar, counts the number of cells that
contain a value (be it numerical or text).
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USING COUNT AND COUNTA
Two of the main functions for counting cells are
COUNT and COUNTA. COUNT counts the
number of values in a range excluding text while
COUNTA counts the number of values in a range

including text. For example, if the range is A1:A10
and cell A5 contains the text ‘On Hold”, COUNT will
count 9 cells (as it won’t count cell A5), while
COUNTA will count 10 (as it will count cell A5).

Same
File

Try This Yourself:






Continue using the previous
file with this exercise, or open
the file Statistical
Functions_2.xlsx...
Click in cell B13, then type
=COUNT(B5:N5)
Press
formula

to complete the
4

Click in cell C13, then type
=COUNTA(B5:N5)
Press
formula

to complete the

Currently, both of the results
are the same – let’s delete a
cell in the range...



Click in cell C5, then press
Both Count formulas return
12 because empty cells are
not included in either
calculation...



6

Click in cell F5, type Closed,
then press
Now the formulas return
different values, as text is
only counted by the COUNTA
function...



Select B13:C13, then doubleclick on the fill handle to copy
the formula down and across
to cell C18
7

For Your Reference…

Handy to Know…

To use the COUNT function:
1. Click in a cell, then type =COUNT(range)
2. Press

 A blank cell is seen as a text value and will
therefore be included by COUNTA but not
COUNT.

To use the COUNTA function:
1. Click in a cell, then type =COUNTA(range)
2. Press
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USING COUNTBLANK
The COUNTBLANK function can be used to
count the number of cells in a range that contain
no information – that is, the number of empty
cells. COUNTBLANK could be used, for

Same File

Try This Yourself:

example, in a data list that records fees paid, to
indicate the number of unpaid fees. Those cells
that do not contain a paid fee value will be blank
and therefore counted in the calculation.

1

Continue using the
previous file with this
exercise, or open the file
Statistical
Functions_3.xlsx...



Click in cell D13, then
type
=COUNTBLANK(B5:N5
)



Press
to complete
the formula

2

The result 1 will be
displayed – this is
because there is no
value in cell C5...



Click in cell D13, then
double-click on the fill
handle to copy the
formula down to cell
D18
3

For Your Reference…

Handy to Know…

To use the COUNTBLANK function:
1. Click in a cell
2. Type =COUNTBLANK(range)
3. Press

 When using the COUNTBLANK function,
cells with zero values are not counted.
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USING COUNTIF
You might need to count cells that contain a
specific value or conform to specific guidelines,
such as how many cells have a value greater
than 10, or hold a particular label. This type of

Same File

Try This Yourself:



1

Continue using the
previous file with this
exercise, or open the file
Statistical
Functions_4.xlsx...
Click in cell E13, then
type
=COUNTIF(B5:N5,">300
00")
In this example we will
count only the Tuesdays
where the takings
exceeded $30,000...



counting can be achieved with the COUNTIF
function. This function counts the number of cells in
the range that satisfy the criteria. The criteria can
take the form of a number, text or an expression.

2

Press
to complete
the formula
The number of days is
2...



Click in cell E13, then
double-click on the fill
handle to copy the
formula down to cell E18
3

For Your Reference…

Handy to Know…

To use the COUNTIF function:
1. Click in a cell
2. Type =COUNTIF(range, criteria)

 If you wish to count cells that contain a
specific value or conform to specific
guidelines across multiple ranges, you can
use the COUNTIFS function.

© 2017 The University of Nottingham

Page 32

Chapter 4 - Statistical Functions

Microsoft Excel 2016 - Simple Calculations

USING MODE
The MODE function returns the value that occurs
most frequently within a given range. The value
must occur more than once or the MODE
function will return the error #N/A meaning that it

Same File

Try This Yourself:




2

Continue using the
previous file with this
exercise, or open the
file Statistical
Functions_5.xlsx...
Click in cell F13 and
type =MODE(B5:N5)
Press
to
complete the formula
The error #N/A will
appear as there are
no repeating values...



is not applicable. This might be useful if you are
analysing test scores and are interested to know
which score was the most frequently achieved.

3

Click in cell C5 and
type 17200, then
press
The Mode value now
changes to 17200 as
the value appears
twice in the range
indicated...



Click in cell F13 and
double-click on the fill
handle to copy the
formula down to cell
F18

4

All of the remaining
Mode values will be
represented by the
error #N/A

For Your Reference…

Handy to Know…

To use the MODE function:
1. Click in a cell
2. Type =MODE(range)
3. Press

 When using the MODE function, any cells in
the selected range that do not contain values
are ignored. However, cells that contain a
zero (0) value are included.
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 The related functions MEDIAN and
AVERAGE are also commonly used, along
with MODE, when working with scores.
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USING MEDIAN
The MEDIAN function returns the number that is
in the middle of a selected range of values when
arranged in ascending or descending order. That
is, the point at which exactly half of the numbers

Same File

Try This Yourself:




1

Continue using the
previous file with this
exercise, or open the
file Statistical
Functions_6.xlsx...
Click in cell G13 and
type =MEDIAN(B5:N5)
Press
to complete
the formula
The value 20650.5 is
returned. As there are
12 entries in the range
(i.e. an even number,
since one cell contains
text), Excel averages
the two numbers in the
centre of the numbers,
arranged from highest
to lowest. Those two
numbers would be
20608 and 20693...



in the range are lower and half of the numbers in
the range are higher. This might be useful, for
instance, when dealing with scores to locate the
midway point.

Click in cell G13, then
double-click on the fill
handle to copy the
formula down to cell
G18

2

3

For Your Reference…

Handy to Know…

To use the MEDIAN function:
1. Click in a cell and type =MEDIAN(range)
2. Press

 When using the MEDIAN function, if there is
an even number of numbers in the selected
range, the function will calculate the average
of the two numbers in the middle of that
range.
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USING LARGE AND SMALL
The LARGE and SMALL functions enable you to
locate values based on their relative standing
within the selected range. For instance, if you
want to find the second highest value, you could

Same
File

Try This Yourself:



use the LARGE function. This might be useful in a
data list recording sales, to locate the first, second
and third highest sales in a month. The SMALL
function enables you to locate the smallest values.

2

Continue using the previous
file with this exercise, or
open the file Statistical
Functions_7.xlsx...
Click in cell H13, then type
=LARGE(B5:N5,1)
This will locate the highest
sale recorded for Tuesdays...



Press
formula

to complete the

4

The value 32991 is returned.
But what if we want the
second highest value?



Click in cell H13, double-click
on the 1 in the Formula Bar,
then type 2



Press



Click in cell H13, then
double-click on the fill handle
to copy the formula to cell
H18

Notice the value 32182 is
displayed…
7

Now for the lowest values...



Click in cell I13, type
=SMALL(B5:N5,3), then
press
to return the third
lowest value



Repeat step 5 to copy the
formula from cell I13 down to
cell I18

For Your Reference…

Handy to Know…

To use the LARGE or SMALL function:
1. Click in a cell
2. Type =LARGE(range,# largest value
within range), or
Type =SMALL(range, # smallest value
within range)

 When using the LARGE and SMALL
functions, if the argument k is less than or
equal to zero, or greater than the number of
selected cells, a #NUM! error is returned.
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USING STDEV
The standard deviation measures how widely
values are dispersed from the mean (average)
based on a sample (STDEV.S()) or on the entire
population (STDEV.P()). The standard deviation

Same
File

Try This Yourself:




is calculated using the n-1 method as follows:

2

Continue using the previous
file with this exercise, or
open the file Statistical
Functions_8.xlsx...
Click in cell J13, then type
=STDEV.S(B5:N5)
Press
formula

to complete the

The STDEV.S function
should only be used with a
sample of the population. If
your data includes the entire
population, as is the case
with our worksheet, you
should use STDEV.P...



Click in cell J13, then modify
the formula in the Formula
Bar so that it reads
=STDEV.P(B5:N5)



Press
to complete the
formula and see the revised
calculation



Click in cell J13, then
double-click on the fill handle
to copy the formula down to
cell J18

3

5

For Your Reference…

Handy to Know…

To use the STDEV function for a sample:

 The STDEVA function also estimates the
standard deviation based on a sample, but
includes text and logical values (TRUE and
FALSE – where TRUE has a value of 1 and
text and FALSE have a value of 0).

 Click in a cell and type =STDEV.S(range)
To use the STDEV function for an entire
population:
 Click in a cell and type =STDEV.P(range)
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USING VAR
The VAR.S function is used to calculate the
variance of numbers from the mean within a
sample range. The larger the variance, the more
the values vary from the mean. The VAR function

Same File

Try This Yourself:



is often used by statisticians along with the STDEV
function to analyse a list of numbers. Although it is
possible to manually calculate variance, it is a very
lengthy process – the VAR function is instant.

2

Continue using the
previous file with this
exercise, or open the
file Statistical
Functions_9.xlsx...
Click on the Variance
worksheet tab to make
this the active
worksheet
Variance is commonly
applied to test scores
to determine how
much the values vary
from the mean...




Click in cell D21, then
type =VAR.S(A4:A20)

3

Press
to
complete the formula

For Your Reference…

Handy to Know…

To use the VAR function for a sample:
1. Click in a cell
2. Type =VAR.S(range)

 The variance is a squared number, so it can
prove tricky to interpret this value in relation
to the mean. Because of this, statisticians
calculate the square root of the variance and
this is called the standard deviation.
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NOTES:
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CHAPTER 5

DATE AND TIME FUNCTIONS

INFOCUS

Excel is primarily designed to perform calculations with numbers. It
can also help you perform complex calculations using dates and
times. This is achieved by first converting dates and times to
numbers.
The Date & Time functions are designed to facilitate date and time
conversions and calculations.

In this session you will:
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gain an understanding of date and time functions
learn how to use the NOW function
learn how to use the HOUR and MINUTE functions
learn how to use the TODAY function
learn how to calculate a future date
learn how to use the DATE function
learn how to use the DAY, MONTH and YEAR functions
learn how to use the WEEKDAY function
learn how to use the WEEKNUM function
learn how to use the WORKDAY function
learn how to use the EOMONTH function.
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UNDERSTANDING DATE AND TIME FUNCTIONS
Excel enables you to perform calculations using
dates and times – for instance, you might want
to determine the number of days between two
dates or the hours worked in a particular day. To

perform these calculations, Excel converts the
dates or times to numbers, then performs the
required calculations, before converting the
numbers back to dates and times.

Processing Dates and Times
By converting the data to a number, Excel can then perform calculations on the numbers before
converting it back to a date or time value.
The serial number assigned to each date is calculated on the basis that serial number 1 is the date
January 1, 1900. So, for instance, January 11, 1900 would be assigned the serial value 11. In this way,
Excel can use the serial numbers to conduct date calculations.
The serial number assigned to each time is calculated as a value in units of 1/60 th of a second. In this
way, each time can be represented as a number between 0 and 1, where 12:00:00 AM is 0.00.
In the image below, the Date and Serial Value columns contain the same data but they display
differently due to the formatting applied: The Date format is applied to the Date values and the Number
format is applied to the Serial Values.

Calculating with Dates and Times
As you can see from the image above, dates and times are recognised as serial values and can
therefore be used in calculations. If you wanted to calculate the number of days between two dates,
such as (17/11/15) and your next birthday (24/4/16), Excel will convert both dates to numbers (39532
and 39866 respectively) and then subtract them – giving a result of 159 days.

Formatting Dates and Times
Although Excel uses the serial numbers to conduct date and time calculations and to present the result
of that calculation, serial numbers are not very meaningful to the average user. To overcome this, you
might need to apply a Date or Time format to the result of the calculation to make it meaningful. To see
the serial number of a date or time, however, use the General or a Number format.
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Page 40

Chapter 5 - Date and Time Functions

Microsoft Excel 2016 - Simple Calculations

USING NOW
The NOW function is used to return the current
date and time. When you enter the NOW function
into a cell, Excel will automatically format the cell
so that you can read the date and time in a

familiar format. For example, NOW could display
25/3/16 1:54 which represents 1:54PM on March
25th, 2016. NOW is particularly useful where the
date and time need to be updated frequently.

Open
File

Try This Yourself:




Before starting this
exercise you MUST open
the file Date And Time
Functions_1.xlsx...
On the NOW worksheet,
click in cell C7
Type =NOW(), then press
The current date and time
will be displayed, although
the column will be too
narrow. We only want to
see the time portion...



Click in cell C7, click on
the Home tab, then click
on the dialog box launcher
for the Number group to
display the Format Cells
dialog box



On the Number tab,
ensure Custom is
selected in Category,
click on h:mm AM/PM in
Type, then click on [OK]



2

3

Click in cell D7, type =C7B7, then press
This calculates the
duration but we want to
see it shown in hours and
minutes...



Select the range C7:D7,
then double-click on the fill
handle to copy the formula
6

For Your Reference…

Handy to Know…

To use the NOW function:
1. Click in a cell, type =NOW(), then press

 When you use the NOW function, the
resulting formula is known as volatile
because it keeps changing. Each time that
the worksheet is modified, the result of the
formula is updated. You can also update the
result manually by pressing
.

2. Click on the Home tab, then click on the
dialog box launcher for the Number group
3. Select the desired option under Type and
click on [OK]
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USING HOUR AND MINUTE
The HOUR function is used in Excel to extract
the number of hours as a value from time data
and the MINUTE function is used to extract the
number of minutes. For example, if the time is

11:45, HOUR will return 11 and MINUTE will return
45. These functions can be used together to
calculate the total number of minutes in a duration
This can be used in things such as costing models.

Same File

Try This Yourself:




Continue using the
previous file with this
exercise, or open the file
Date And Time
Functions_2.xlsx...
On the NOW worksheet
click in cell G7
Type =((HOUR(D7)*60)+
MINUTE(D7))*E7*F7
This formula takes the
total hours and multiplies
it by 60 to convert it to
minutes. It then adds the
minutes component to
calculate the total
minutes. Finally, it
multiplies this figure by
the flow in litres per
minute to generate the
cost per litre...




2

3

Press
to complete
the formula
Click in cell G7, then
double-click on the fill
handle to copy the
formula down the column
The times and therefore
costs will vary depending
on the time of day that
you are looking at the
worksheet

4

For Your Reference…

Handy to Know…

HOUR(serial_number)
This function returns the hour portion of a time
as an integer (0-23) corresponding to a serial
number.
MINUTE(serial_number)
This function returns the minutes as an integer
(0-59) corresponding to a serial number.

 The SECOND function works in a similar way
to HOUR and MINUTE, returning the
seconds portion of a time as an integer
between 0 and 59.
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USING TODAY
The TODAY function is similar to NOW in that it
refers to the current day. However, TODAY only
returns the current date, not the date and time.
This function is perfect for formulas that require

Same File

Try This Yourself:
Continue using the
previous file with this
exercise, or open the file
Date And Time
Functions_3.xlsx...



On the TODAY
worksheet tab click in
cell C7




Type =(TODAY()–
B7)/365.25
Press
to complete
the formula

the date part only of the current day. In many
situations TODAY and NOW can be used
interchangeably.

2

3

6

Let’s create a custom
format for the result...



Click in cell C7,click on
the Home tab, then click
on the dialog box
launcher for the
Number group to
display the Format
Cells dialog box



On the Number tab,
click on Custom in
Category



Double-click on the
value in Type to select
it, then type #,##0.0
“yrs”




Click on [OK] to apply
the format

8

Double-click on the fill
handle to copy the
formula to cell C11

For Your Reference…

Handy to Know…

TODAY()
This function returns the current date. It has no
arguments but must be followed by paired
brackets.

 To extract the time part only of the current
date and time, use the formula
=NOW()–TODAY()
This will display the fractional part of the
serial number that is the current date and
time. You can then apply one of the Time
formats to suit your needs.
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CALCULATING FUTURE DATES
Once you have entered dates into a worksheet
either directly by typing them in, or indirectly
through one of the date functions, you can easily
project forward using simple arithmetic to

Same File

Try This Yourself:
Continue using the
previous file with this
exercise, or open the file
Date And Time
Functions_4.xlsx...



On the TODAY
worksheet, click in cell
E7




Type =B7+(D7*365.25)
Press
to complete
the formula

calculate future dates. In this example, we will use
the purchase date of an item or equipment, plus its
expected length of use in years, to project its
possible retirement or replacement date.

2

3

6

The date will appear as
a serial number, so we
need to apply a format...



Click in cell E7, click on
the Home tab, then click
on the dialog box
launcher for the Number
group to display the
Format Cells dialog box



On the Number tab,
click on Custom in
Category



Double-click on the
value in Type to select it,
then type mmmm yyyy




Click on [OK] to apply
the format

8

Double-click on the fill
handle to copy the
formula down to cell E11

For Your Reference…

Handy to Know…

To calculate future dates:
1. Calculate the number of days by multiplying
the number of years by 365.25
2. Add the days to the existing date
3. Format the result as a date

 Remember that the serial number that
represents a date is the number of days
since January 1, 1900. As long as you are
careful to convert everything to the same
units, such as days, creating your date
calculations should be quite simple.
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USING DATE
The DATE function is used to assemble a date
from three separate pieces of data, being the
year, month and day. This is useful if the
information is provided in separate columns and

you need to combine them. DATE will take the
year, month and day and convert them to a single
serial number representing the date. The result is
automatically formatted as a date.

Same File

Try This Yourself:
Continue using the
previous file with this
exercise, or open the file
Date And Time
Functions_5.xlsx...



Click on the DATE
worksheet tab, then click in
cell E7





Type =DATE(D7,C7,B7)
Press
formula

1

to complete the
2

Click in cell E7, then
double-click on the fill
handle to copy the formula
to cell E11

Showing all four digits of
the year in the date format
enables you to quickly
check that the data is
correct – for instance, “00”
could represent 1900 or
2000 – if the data in the
year column was
incorrectly typed, you
might not pick this up with
only a 2-digit year format

3

4

For Your Reference…

Handy to Know…

DATE(year,month,day)
This function returns a serial number that
represents a date. The date is assembled from
separate year, month and day values.

 Excel is very forgiving when handling dates –
when you type a date into a worksheet, Excel
automatically recognises it as a date, records
it as a serial number and displays it as a
date.

© 2017 The University of Nottingham
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USING CALENDAR FUNCTIONS
The DAY, MONTH and YEAR functions are used
to extract the day, month and year parts of a
date respectively. In effect, these formulas
perform the opposite of the DATE function which

assembles the day, month and year to form the
date. The parts of the date, once separated, can be
used for display purposes or in further date
calculations that focus on specific components.

Same File

Try This Yourself:





Continue using the
previous file with this
exercise, or open the file
Date And Time
Functions_6.xlsx...

2

On the DATE worksheet,
click in cell G7
Type =E7+(F7*365.25)
Press
formula

to complete the

The result appears as a
serial number, so let’s
format it...



Click in cell E7, click on the
Home tab, click on Format
Painter in the Clipboard
group, then click in cell G7
to apply the format



Click in cell H7, type
=DAY(G7), then press



Click in cell I7, type
=MONTH(G7), then press



Click in cell J7, type
=YEAR(G7), then press



Select G7:J7 then doubleclick on the fill handle to
copy the formulas down

4

6

8

For Your Reference…

Handy to Know…

DAY(serial_number)
This function returns the day as an integer (1 to
31) corresponding to a serial number.
MONTH(serial_number)
This function returns the month as an integer (1
to 12) corresponding to a serial number.

YEAR(serial_number)
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USING WEEKDAY
The WEEKDAY function returns the day of the
week expressed as a number. By default, Excel
defines the first day of the week as Sunday and
represents this with the value 1. Alternatively, you

can add a parameter to the function to specify
Monday as the first day of the week, with a value
of 0 or 1. If you format the value as dddd,
WEEKDAY will display the name of the day.

Same File

Try This Yourself:
Continue using the
previous file with this
exercise, or open the file
Date And Time
Functions_7.xlsx...



Click on the WEEKDAY
worksheet tab, then click
in cell C4



Type
=WEEKDAY(TODAY(),2)
By using 2 as the second
parameter, we are
indicating that our week
starts on Monday with a
value of 1...






Press
formula

2

4

to complete the

Click in cell C7, then type
=IF(B7=$C$4,"Yes","No")
Press
formula

to complete the

Click in cell C7, then
double-click on the fill
handle to copy the formula
down to cell C11
6

For Your Reference…

Handy to Know…

WEEKDAY(serial_number[, return_type])
This function returns the weekday as an integer
corresponding to a serial number. return_type
is an optional parameter that determines the
start of the week and its value. If return_type is
left blank, it will return Sunday through to
Saturday as the values 1 through to 7.

In the WEEKDAY function, the return_types
are:
Type
Start
Number Range
1
Sunday
1 to 7
2
Monday
1 to 7
3
Monday
0 to 6

© 2017 The University of Nottingham
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USING WEEKNUM
When supplied with a given date, the WEEKNUM
function returns a number representing when that
week falls within the year. This function works on
the basis that the week containing January 1st is

week 1 and the following weeks are numbered
consecutively. The syntax for the WEEKNUM
function is the same as the WEEKDAY function;
that is, it requires a date serial number.

Same File

Try This Yourself:
Continue using the
previous file with this
exercise, or open the file
Date And Time
Functions_8.xlsx...



Click on the DATE
worksheet tab, then click
in cell K7




Type =WEEKNUM(G7,2)
Press
to complete
the formula

2

3

According to the formula,
the retirement date falls
in the 44th week of the
year...



Click in cell K7, then
double-click on the fill
handle to copy the
formula down to cell K11
4

For Your Reference…

Handy to Know…

WEEKNUM(serial_number[, return_type])
This function returns the week number as an
integer, representing the week where the date
falls in the year. return_type is a number that
determines on what day the week begins. The
default is 1 (Sunday). If return_type is 0 the
start day is Sunday and if 2, it is Monday.

 The WEEKNUM function in Excel considers
the week containing January 1 to be week 1;
however a problem arises with the European
standard which determines that week 1 is the
one with the majority of days (i.e. four or
more). WEEKNUM therefore creates
incorrect results for European standards.
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USING WORKDAY
The WORKDAY function returns a date which is
a specified number of days from a start date.
Optionally, you can indicate holidays that occur
within the given period, so that the calculated

workday is correct. This function works in a
Monday to Friday work environment and might be
used, for instance, to calculate the end date of a
project.

Same File

Try This Yourself:
Continue using the
previous file with this
exercise, or open the file
Date And Time
Functions_9.xlsx...



Click on the WORKDAY
worksheet tab, then click
in cell B7



Type
=WORKDAY(A7,C7,F4:
F7)
In this function, the
parameters are the start
date, the number of days
that the project is
expected to take and
holidays that fall on
workdays...



1

2

Press
to complete
the formula
The function calculates
that 20/03/2014 will be
the finish date, based on
the given conditions
3

For Your Reference…

Handy to Know…

WORKDAY(start_date, days[, holidays])
This function returns the date that is the
specified number of days from the start_date.
holidays is an optional parameter indicating
when weekday holidays occur within the period
indicated.

 If you want to calculate the number of
workdays between two dates, you need to
use the NETWORKDAYS function (not the
WORKDAY function).
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USING EOMONTH
The EOMONTH function is used to return the
serial number for the last day of the month, a
specified number of months before or after a start
date. You could use this function, for instance, to

calculate due dates or maturity dates of
investments that occur on the last day of the
month. You must format the result of the function to
view it in a date format.

Same
File

Try This Yourself:



Continue using the previous
file with this exercise, or
open the file Date And Time
Functions_10.xlsx...
Click on the EOMONTH
worksheet tab, then click in
cell D7

2

Let’s calculate the payout
dates for the staff’s next
three investments, paid at
the end of each six month
period...





Type =EOMONTH(C7,6)
Press
formula

to complete the

3

Click in cell E7, then repeat
steps 2 and 3, replacing the
6 with 12 in the formula to
calculate the 12 month date
You could also have
entered the formula
=EOMONTH(D7,6)…



Click in cell F7, then repeat
step 4, replacing 12 with 18
in the formula to calculate
the 18 month date



Select D7:F7, then doubleclick on the fill handle to
calculate the payment dates
for the other employees

4

6

For Your Reference…

Handy to Know…

EOMONTH(start_date, months)
This function returns the last day of the month,
which is the specified number of months before
or after a given start_date.

 In the EOMONTH function, if the months
parameter is a positive number, a future date
will be calculated. If the months parameter is
a negative number, a past date will be
calculated.
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CONCLUDING REMARKS

Congratulations!
You have now completed Microsoft Excel 2016 - Simple Calculations. Microsoft Excel 2016 Simple Calculations was designed to get you to the point where you can competently perform a
variety of operations.
We have tried to build up your skills and knowledge by having you work through specific tasks.
The step by step approach will serve as a reference for you when you need to repeat a task.
Where To From Here?
The following is a little advice about what to do next:
 Spend some time playing with what you have learnt. You should reinforce the skills that you
have acquired and use some of the application's commands. This will test just how much of
the concepts and features have stuck! Don't try a big task just yet if you can avoid it - small
is a good way to start.
 Some aspects of the course may now be a little vague. Go over some of the points that you
may be unclear about. Use the examples and exercises in these notes and have another go
- these step-by-step notes were designed to help you in the classroom and in the work
place!
Here are a few techniques and strategies that we've found handy for learning more about
technology:


read computer magazines - there are often useful articles about specific techniques



if you have the skills and facilities browse the Internet, specifically the technical pages of
the application that you have just learnt



take an interest in what your work colleagues have done and how they did it - we don't
suggest that you plagiarise but you can certainly learn from the techniques of others



if your software came with a manual (which is rare nowadays) spend a bit of time each day
reading a few pages. Then try the techniques out straight away - over a period of time
you'll learn a lot this way



and of course, there are also more courses and books for you to work through.

Hungry for More?
We live in an ever-changing world where we all need to review and upgrade our
skills.
If you have received this course book on a training course why not ask the tutor or
trainer for other courses that may be of benefit to you. If you are attending a
college ask for one of their brochures.
Alternatively, if you’ve enjoyed using this course book you can find others that
cover a wide range of topics at our web site www.watsoniapublishing.com.
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